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Úvodem  
P edm tem této brožury je FrontPage 2000 a jejím 

cílem je praktické zvládnutí základ  tvorby webových 
stránek. Nebudeme se detailn  zabývat prost edím apli-
kace FrontPage nebo podrobnostmi jednotlivých nabídek 
a nástroj . N kte í tená i budou možná postrádat i filo-
zofování nad tím, co to je Internet, kde se vzal Web 
a kam to vše sm uje. Vyhneme se, pokud to jen bude 
možné, i všem technickým podrobnostem. Ú elem zde 
není vy erpávající výklad o aplikaci FrontPage a už v -
bec ne o tak nesmírn  širokém tématu jakým je Internet, 
World Wide Web a vývoj aplikací. S touto p íru kou bys-
te ale m li být schopni vytvo it fungující web bez znalosti 
programování a seznámit se s n kterými základními 
technikami a jejich použitím v programu FrontPage. 

Pokud budete pot ebovat nahlédnout do kuchyn  In-
ternetu, jeho protokol , technických podrobností sítí ne-
bo programovacích jazyk , najdete na našem knižním 
trhu adu publikací – mezi nimi dokonce n které docela 
dobré. Na tuto brožuru navážou postupn  další, které se 
budou zabývat nap . grafickým návrhem webových strá-
nek, vývojá skými nástroji i vlastním jazykem HTML. 
Zam ení t chto publikací máte v rukou i vy sami. Po-
dívejte se na anketu na www.win.cz nebo www.idg.cz, 
kde m žete svým hlasem ovlivnit témata dalších p ipra-
vovaných sešit  edi ní ady PCWorld Edition. 

Svoje p ipomínky, nám ty a poznámky zasílejte:  
UNIS Publishing, s.r.o. 
Jundrovská 33, 624 00 Brno 
tel.: 05 – 4  5  55 00    fax: 05 – 4  5  55 02 
e-mail: knihy@win.cz 
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Internet a web 
O Internetu již bylo napsáno takové množství zasv cených i povrchních materiál , že jste se ur it  

s n kterým z nich setkali, a to i v p ípad , že tete pouze n který z asopis  zabývajících se pohlavním živo-
tem našich prominent . Internet je všude kolem nás, a o tom, že se stále ší í, a že stále více lidí hledá aktivní 
p ístup k n mu, sv d í i to, že jste si koupili tuto publikaci. I když pravd podobn  v tšinu základních pojm  
z oblasti Internetu znáte, bude na míst  si alespo  vybrané pojmy p ipomenout. Na tomto míst  bych cht l 
p ipomenout n které námi vydané publikace, které mohou pomoci zájemc m o pokro ilejší témata: 

Active Server Pages 3.0 Profesionáln  ( 200 stran, vyšlo v roce 2000) 
VBScript Pr vodce vývojá e (780 stran, vyšlo v roce 2000) 
Elektronický obchod s Visual Basicem, ASP, SQL Server a MTS (600 stran, únor 200 ) 
Hacker Proof – bezpe nost Internetu (aktualizované vydání, b ezen 200 ) 

N které základní pojmy 
Internet 
Vlastní slovo Internet je zkratkou slova internetwork (asi bychom mohli íci „prost edí propojených po í-

ta ových sítí“, nebo „sí  po íta ových sítí“). P vodním zám rem bylo vytvo it univerzální systém pro agen-
turu Advanced Research Project Administration ministerstva obrany USA (DARPA), následovalo jeho 
rozší ení na akademickou p du a od po átku 90. let se Internet stal neustále rostoucím informa ním prost e-
dím umož ujícím komunikaci mezi nes etným množstvím po íta  na celém sv t . Internet nemá majitele, je 
to sada r znorodých po íta ových sítí propojených prost ednictvím bran, které zpracovávají p enos dat a p e-
vod zpráv a komunikují spolu prost ednictvím sady protokol  TCP/IP. 

Intranet 
Všeobecn  používaný termín ozna ující využití internetových technologií v interních sítích organizací. 

Jedná se o sí  s protokolem TCP/IP, která m že, ale v bec nemusí být p ipojena k síti Internet. 

WWW 
World Wide Web (WWW nebo jenom Web) – jedná se o jednu z nejmladších služeb v síti Internet.  In-

formace jsou v síti WWW doru ovány ve form  hypertextu a hypermedií, obvykle pomocí jazyka HTML, 
s dokonale zpracovanými schopnostmi odkazování. Sí  WWW je sada hostitelských systém  sít  Internet, 
která tyto služby v síti Internet zp ístup uje pomocí protokolu HTTP. WWW sí  je možné si p edstavit jako 
množinu dokument  – webových stránek – uložených na nejr zn jších HTTP serverech na celém sv t  a do-
stupných na základ  URL (viz URL).  

TCP/IP 
Transmission Control Protocol/Internet Protocol. Komunika ní standard pro všechny po íta e v rámci  

Internetu. Protokol TCP na stran  odesílání d lí data, která mají být odeslána, na datové segmenty. Protokol 
IP za azuje segmenty do paket  ( ást informace odesílaná prost ednictvím sít  s pevnou strukturou i velikos-
tí) obsahujících vedle vlastních dat v binární, tj. neznakové podob , také záhlaví s identifika ním íslem, 
zdrojovou a cílovou adresou a údaje pro kontrolu chyb. Protokol IP poté pakety odesílá k doru ení do sm ro-
va e. Na stran  p íjemce protokol IP p ijme pakety, rozloží je zp t na datové segmenty dat, a protokol TCP je 
uspo ádá do p vodní sady dat. 
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Za ínáme – web za 5 minut 
Nejlépe bude pustit se hned do práce. Byli jste na zajímavé dovolené, máte adu fotografií a mnoho p átel 

po celé republice. Nejjednodušším zp sobem, jak se pod lit o zážitky z cesty, bude vytvo it web a dát o n m 
svým p átel m a známým v d t. Nebudeme se zabývat sehnáním poskytovatele internetových služeb – pro-
videra; r zné nabídky i na bezplatné z ízení jednoduchého webu najdete na ad  známých portál . Vše, co te-
dy pot ebujete ud lat, je vytvo it obsah a strukturu webu a p enést je na vyhrazené místo u providera. Sedn te 
tedy k po íta i a pus te se do práce. 

Jednostránkový web 
Po spušt ní programu FrontPage se otev e základní okno aplikace, které je rozd leno na n kolik ástí. 

P evážnou ást prvk  okna dob e znáte: titulkový pruh s ovládacími tla ítky a systémovou nabídkou, pruh 
nabídek, panel základních nástroj  apod. Standardn  se p i levém okraji okna zobrazí panel zobrazení 
s ikonami, které reprezentují jednotlivé režimy zobrazení ur ené pro specifické práce na vašem webu. 

 

 

Základní okno aplikace 
FrontPage. Toto standardní 
nastavení m žete zm nit 
a individuáln  p izp sobit 
obdobn  jako u všech aplikací 
sady MS Office 2000. Panely 
nástroj  lze p etažením umístit 
k jiným stranám okna nebo je 
ponechat jako samostatné 
plovoucí panely. Pomocí View 
> Toolbars m žete zapnout 
zobrazení jiných panel  
nástroj , p ípadn  p íkazem 
View > Toolbars > Customize 
libovoln  pracovní prost edí 
a jeho nástroje upravit.  

  
Pro vytvo ení nového webu vyberte postupn  položky File > New > Web. Otev e se dialogové okno, ve 

kterém se nabízejí základní šablony web . Jak m žete v okn  vid t, je zde p edp ipravena celá ada možností, 
jak rychle vytvo it základ webu. Protože práv  za ínáme, vybereme to nejjednodušší – One Page Web (jed-
nostránkový web). Na pravé stran  okna v rozbalovacím seznamu Specify the location of the new web (Ur i 
umíst ní nového webu) napište, kde se má nový web vytvo it. V podstat  m žete zvolit n kolik druh  umís-
t ní: p ímo váš webový server – v tomto p ípad  byste zadali adresu, nap . http://mujweb/dovolena. Web by se 
vytvá el p ímo na webovém serveru a pokud by vše bylo v po ádku, byl by ihned funk ní. Tento režim práce 
je ale t eba zásadn  zavrhnout. M žete si ho snad dovolit na intranetu na vaší lokální síti, ale jinak nikdy ne-
umis ujte na webový server n co, co nemáte ov eno a zkontrolováno. Navíc se vystavujete nebezpe í, že p i 
výpadku p ipojení p ijdete o data, práce se zbyte n  zpomaluje a našli bychom adu dalších d vod , pro  n -
co takového ned lat. A kone n , takovýto režim práce by vám musel umožnit i váš provider. My budeme 
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Na záv r této ásti se ješt  podíváme na možnosti vytvá ení miniatur pro zobrazování grafiky. Z r zných 
d vod  m že být užite né zobrazovat místo skute ného obrázku pouze jeho miniaturu, m že to být p ehled-
n jší, stažení stránky je rychlejší... Vložení miniatury místo plného obrázku je velmi jednoduché: na defini-
tivní místo vložíte skute ný obrázek, klepnete na n j a klepnete na tla ítko Auto Thumbnail na panelu nástroj  
Picture. To je vše. 

 

 

Vlastnosti zobrazení miniatury up esníte na 
kart  Auto Thumbnail v dialogovém okn  Page 
Options, které otev ete p íkazem Tools > Page 
Options. 
Na této kart  m žete nastavit rozm r 
miniatury: vyberte jeden z rozm r , který 
chcete nastavit a zadejte v poli Pixels jeho 
velikost v obrazových bodech (pixelech). 
Vybrat m žete ší ku (Width), výšku (Height) 
nebo nejkratší/nejdelší stranu 
(Shortest/Longest Side). 
Dále m žete zvolit tlouš ku ráme ku kolem 
miniatury zaškrtnutím polí ka Border thickness 
a zadáním tlouš ky v pixelech. Poslední 
polí ko umož uje zobrazit miniaturu se 
zkosenými okraji. 

 

 

Miniatura p edstavuje vlastn  samostatný, 
z originálu nov  vytvo ený obrázek, a m žete 
tedy nastavit jeho vlastnosti. Klepn te na 
miniaturu pravým tla ítkem a vyberte p íkaz 
Picture Properties. V dialogu, který se 
následn  objeví, m žete mimo jiné nastavit cíl 
odkazu, tedy dokument, který se má v 
prohlíže i zobrazit, pokud klepnete na 
miniaturu. Protože jsme vytvá eli miniaturu 
z vloženého obrázku, je zde uveden práv  
odkaz na tento p vodní obrázek. 
Pro nastavení zp sobu zobrazení tohoto 
dokumentu klepn te na tla ítko s tužkou vedle 
polí ka Target Frame (cílový rám, okno). Blíže 
si použití t chto nastavení ukážeme 
v následujících ukázkách. 
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Vylepšujeme web 
Po prvním p ekotném za átku budeme náš návrh webu vylepšovat. Ke všemu použijeme pouze nástroje, 

které nám poskytuje FrontPage. P itom se budeme snažit o maximální zjednodušení naší práce, nejsme ani 
profesionálové grafici, ani specialisté vývojá i. 

Šablony 
Použití šablon (template) znáte již ur it  z jiných aplikací MS Office, asi nej ast jší je jejich používání ve 

Wordu. Šablona je p edp ipravený dokument, který m že obsahovat nejr zn jší prvky spole né pro všechny 
vytvá ené stránky – od základního formátování, podbarvení nebo podtisku až po nejr zn jší prvky vložené na 
stránku. Používáním šablon se zjednoduší a zrychlí p íprava stránek a zajistí se jejich jednotný vzhled. Velmi 
d ležité je používání šablon v p ípad , že stránky vytvá í více pracovník , nap íklad v místní síti intranet.  

FrontPage podobn  jako i ostatní aplikace MS Office nabízí celou adu již p edp ipravených šablon. 
K dispozici máte jak šablony pro vlastní stránky, tak i celé p edp ipravené weby pro ur ité standardní nasaze-
ní. Podívejme se nejprve na šablony samotných stránek.  

 

 

Dialogové okno New se otev e 
p íkazem File > New > Page. 
Pokud zvolíte novou stránku 
jiným zp sobem (tla ítko na 
panelu nástroj , z místná 
nabídky...) vloží se nová 
prázdná strna. 
Jak vidíte, obsahuje tento 
dialog t i karty, nás z toho bude 
zajímat pouze karta General. 
(Druhá záložka se týká stránek 
d lených na rámy a t etí tzv. 
kaskádových styl .) Šablonu 
zvolíte klepnutím na ikonu 
a potom tla ítkem OK. Jak 
vidíte, zobrazuje se vpravo dole 
náhled stránky. 
 

 
Nemá smysl zde popisovat, co na které šablon  je a k emu je vhodná, nejlépe vám poslouží práv  ná-

hled. Po vytvo ení nové stránky m žete upravovat jednotlivé již p edp ipravené prvky a samoz ejm  p idávat 
prvky vlastní. Obrázek na následující stran  ukazuje jak vypadá stránka vytvo ená na základ  jedné ze šablon. 

FrontPage vám umož uje samoz ejm  i navrhovat vlastní uživatelské šablony. P i vytvá ení šablony 
stránky postupujte stejn , jako byste p ipravovali b žnou stránku. Naformátujte stránku a vložte všechny spo-
le né objekty. Rozvažte, které objekty budou na všech stránkách vždy stejné (nap . firemní logo, provedení 
záhlaví stránky a podobn ) a které chcete na finální stránce ješt  individuáln  upravovat. V tomto druhém 
p ípad  je vhodné zvolit takový text nebo obrázek, který na pot ebu úpravy z eteln  upozorní. Všimn te si, že 
i implicitní šablony FrontPage obsahují nap . místo skute ného textu cosi nesrozumitelného tak, aby i na prv-
ní pohled bylo z ejmé, že se prvek musí upravit. 
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V rozbalovacím seznamu Item si vyberte položku, kterou chcete zm nit. Nebudu zde uvád t p eklady ná-
zv , protože každý prvek v ukázce na prav  polovin  dialogového okna má uvedenu popisku. Chcete-li tedy 
zm nit nap . grafický vzhled titulku, vyberte v rozbalovacím seznamu Item položku Banner. Na kart  Picture 
se popiska u textového pole zm ní na Banner a m žete bu to zadat název obrázku ve formátu gif, který chce-
te použít, nebo ho vyhledat tla ítkem Browse. Ve vyhledávacím okn  máte nabídku obrázk , které jsou do-
stupné p ímo ve vašem webu, m žete ale použít tla ítko pro vyhledání jak na internetu, tak i na pevném disku 
po íta e. Obrázek, který použijete nemusí být ve formátu gif, ale bude do n j p eveden. P ipomínám pouze, 
že gif obrázek podporuje max. 256 barev a proto m že p i konverzi dojít ke ztrát  barevné kvality obrázku. 
Za vhodn jší považuji provést úpravu obrázku, tj. nastavení p esných rozm r  a barev mimo FrontPage 
v n kterém grafickém editoru. 

Na kart  Font m žete nastavit písmo použité pro p íslušné texty na grafickém prvku. 

Text 
Posledním tla ítkem pro úpravy tématu je tla ítko Text. V dialogovém okn , které se zobrazí m žete na-

stavit písmo pro každý styl textu, který se používá na vaší stránce, tj. normální  text, nadpis ... Písmo je 
možné pozd ji zm nit, ale zde provedete po áte ní nastavení tak, jak vám budou v tšinou vyhovovat. 

Uložení vlastního tématu 
Jakmile provedete n které zm ny v nastavení barev, obrázk  nebo textu, objeví se na panelu 

v dialogovém okn  Themes další dv  tla ítka: Save (uložit) a Save as (uložit jako). Tla ítkem Save byste 
provedli zm nu zabudovaného tématu a proto doporu uji zvolit Save as, které uloží zm ny jako uživatelem 
definovaný styl pod zadaným jménem. Podobn  jako u práce se šablonami, ani zde se numusíte starat o místo 
uložení. Uživatelská témata jsou automaticky ukládána do složky C:\Windows\Application Data\Microsoft 
\Motivy do složek, které jsou ozna ovány podle zadaného názvu uživatelem vytvo eného tématu. Na za átku 
této ásti jsem se zmínil o po ešt ní Theme na Motiv v aplikacích Office, zde vidíte, že i složka, ve které jsou 
motivy/témata uloženy, má eský název. Ale ur it  nepoužívejte eský název pro vlastní vytvo ené téma. Ná-
zev se sice bude správn  zobrazovat v seznamu témat, ale v názvu podsložky, ve které bude na disku uložen, i 
vlastního souboru budou eské znaky a mezery nahrazeny krátkou poml kou. 

Tabulky 
Pokud jsme s globálními úpravami vzhledu našeho webu spokojeni, m žeme se pustit do práce na strán-

kách. Je zapot ebí si uv domit, že základem HTML stránek je vlastn  textová stránka. Pomineme-li r zná vy-
lepšení, jde o plynulý text, do kterého jsou vkládány nap . obrázky. Rozvržení textu na stránce je do zna né 
míry vázáno na velikost stránky. To, jestli bude obsah znázorn n t emi ádky nebo se vejde na jeden, je dáno 
aktuální velikostí okna prohlíže e, použitým rozlišením a nastavenou velikostí písma. To je velmi nep íjemné, 
pokud chcete zachovat ur ité grafické vztahy mezi ur itými objekty. Vzpome te si nap íklad, jak se nám p i 
menším okn  prohlíže e posunul text titulku stránky až do vloženého obrázku. 

Je ada zp sob  jak dosáhnout zachování ur itého nastavení. Jedním z nejpoužívan jších zp sob , 
a sou asn  i velmi jednoduchých, je použití tabulek. Podívejme se na stránku Photo Album tak, jak ji vytvo il 
pr vodce. 
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Web na zelené louce 
Jednoduchý web jsem již dokázali vytvo it, což tak n co složit jšího? Ud láme si web pro knižní vydava-

telství UNISP. A za neme z ni eho, i když jsme si již ukázali použití vzorových web , které jsou k dispozici 
p ímo ve FrontPage a jejichž použití m že výrazn  zkrátit dobu pro vytvá ení webu. 

Vytvo ení nového webu 

 

Spustíme FrontPage 
a zvolíme File > New > Web.  
V nabídce pr vodc  pro 
vytvo ení nového webu 
vybereme Empty web 
(prázdný web) a klepneme na 
tla ítko OK. 
 

 

 

V panelu zobrazení Views 
klepn te na tla ítko 
Navigation. Pracovní plocha 
obsahuje pouze instrukci pro 
další postup.  
Jak m žeme vid t, byla 
vytvo ena pouze základní 
struktura adresá , jinak je 
náš web zcela prázdný. 
Text na ploše íká – pro 
vytvo ení domovské stránky 
klepn te na tla ítko New 
Page. 
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Domovská stránka 
Prvním krokem bude tedy vložení domovské stránky. Klepn te na tla ítko New page na panelu nástroj . 

Pokud bychom cht li použít n kterou p eddefinovanou nebo vlastní šablonu, použili bychom místo toho p í-
kaz File > New > Page. 

 

 

Jedním nebo druhým 
zp sobem vytvo íme novou 
stránku, která obsahuje 
v tomto zobrazení malou 
ikonu dome ku na znamení, 
že se jedná o domovskou 
stránku vytvá eného webu. 
 

Dopln ní stránek 
Pod touto domovskou stránkou bychom cht li vytvo it t i stránky nabízených produkt : Novinky, Knihy 

a PCWE (PCWorld Edition). Klepn te myší na obdélní ek domovské stránky a t ikrát klepn te na tla ítko 
New. 

 

 

Jak vidíte na obrázku, doplnili 
jsme t i nové stránky, jejichž 
rodi ovskou stránkou 
(tj. p ímým p edch dcem) je 
domovská stránka.  
Názvy stránek New Page  ... 
zm níme podle jednotlivých 
produkt . Pozor ale na to, že 
jednou v cí je název (Title) 
stránky a druhou je název 
souboru, ve kterém je stránka 
umíst na. P i vytvo ení m la 
stránka název nap . New 
Page  a zatím nebyla 
umíst na v žádném souboru 
– podívejte se na p edchozí 
obrázek. Ve složce mujweb6 
zatím žádné soubory pro 
stránky New Page  až New 
Page 3 nejsou. 
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Názvy soubor  se generují z aktuálních titulk  stránek. Pokud si chcete ušet it práci, je dobré v d t, že 
struktura soubor  se vytvá í až v okamžiku, kdy bu to web uložíte nebo když p epnete zobrazení z režimu 
Navigation na jiné, nap . Page. Pokud tedy nejd íve zm níte titulek stránky a potom teprve p ejdete do jiného 
zobrazení, budou si vzájemn  názvy soubor  a titulky stránek odpovídat. Pokud teprve následn  zm ním ná-
zev stránky, název souboru z stává již beze zm ny. Pokud byste cht li p izp sobit i název souboru, ud lejte 
to v n kterém z prost edí FrontPage, ne nap íklad pomocí Pr zkumníka. Zm ny provedené ve FrontPage se 
aktualizují automaticky, zm ny které provedete mimo FrontPage mohou narušit konzistentnost vašeho webu.  

Všimn te si, že v místní nabídce p idaných stránek není ihned po vytvo ení stránky k dispozici p íkaz 
Properties (vlastnosti). Ten se zp ístupní teprve až bude vytvo en odpovídající soubor htm. 

 

 

Vedle p ejmenování m žete 
umístit soubory, které pat í 
k jedné stránce, t eba i do 
vlastní složky. Sta í nap íklad 
ve zobrazení Folder list 
(seznam složek) klepnout 
pravým tla ítkem na složku, 
pod kterou chcete vytvo it 
nový adresá . Z místní 
nabídky zvolte New folder 
(nový adresá ). 
Zm nit název takto vytvo ené 
složky m žete nap . pomocí 
místní nabídky (pravé klepnutí 
na složku a p íkaz Rename) 
nebo složku ozna íte a ješt  
jednou klepnete na název.  
 

 

 

Já jsem v ukázce nazval tuto 
složku Novinky a p etáhl jsem 
do ní myší soubor 
new_page_ .htm, který je 
možné také p ejmenovat na 
Novinky.htm.  
Záleží pouze na vás, ale je 
velmi záhodno udržovat 
po ádek a p ehled jak ve 
složkách, tak i v souborech na 
webu. 
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Ke stránce KNIHY bych cht l p idat ješt  len ní podle kategorií, nap . Grafika, Opera ní systémy, Office 
a p ípadn  další. P idám tedy odpovídající stránky.  

 

 

 

 
Tím jsme vytvo ili základní schéma našeho webu a m žeme p istoupit k vytvo ení obsahu a nástroj  pro 

pohyb mezi stránkami. Za n me práv  tím posledn  jmenovaným – navigací. 

Navigace 
N kde na za átku této brožury jsem se zmínil, že Web p edstavuje obrovské množství dokument  rozmís-

t ných po po íta ích (webových serverech) po celém sv t . Každý dokument má svoje umíst ní a je dostupný 
prost ednictvím URL. Stejn  tak je možné p istupovat i k jednotlivým stránkám vašeho webu prost ednictvím 
URL, ale to by obecn  nebylo p íliš š astné ešení, navíc by uživatelé webu museli znát i názvy soubor . Po-
dívejte se nap íklad na strukturu našeho knižního webu. Pokud byste cht li zobrazit nap íklad stránku KNIHY, 
museli byste použít URL ve tvaru http://unispubl/new_page_2.htm. Zde zastupuje unispubl název našeho webu 
(v mém konkrétním p ípad  je to adresa, na které je umíst na domovská stránka na mém Personal Web Serve-
ru). Rozumn jším ešením je doplnit stránky o odkazy, pomocí kterých se m žete pohybovat po jednotlivých 
stránkách našeho webu, ale i mimo n j.  

Na druhou stranu se vám n kdy m že hodit i to, že n které stránky, na které nebudou p ímo ukazovat od-
kazy a naviga ní prvky z jiných stránek, nejsou b žn  dostupné, ale uživatel, který zná URL, se na n  m že 
bez problém  podívat. M žete mít nap . tímto zp sobem vytvo eny "soukromé" stránky pro n které zákazní-
ky apod. Uvozovky jsou zde proto, že tento zp sob d v rné komunikace není v bec bezpe ný.  

Navigaci mezi stránkami, tak jak jsme o ní mluvili, je možné doplnit ru n , ale my využijeme toho, co 
nám nabízí FrontPage – tj. automaticky generovaný naviga ní panel. 

K tomu, abychom mohli velmi snadno tuto možnost použít, využijeme další z prvk  nabízených FrontPa-
gem – tzv. sdílené (spole né) okraje, Shared Brorders. Z nabídky Format vybereme p íkaz Shared Borders 
a podíváme se, co nabízí dialogové okno, které se otev e. 
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umis ování naviga ních tla ítek. Zvolíte-li v tomto dialogu jako umíst ní Absolute, m žete v podstat  p etáh-
nout obsah kamkoliv na stránku. 

Dovolím si na tomto míst  malé upozorn ní. Pokud pracujete se sdílenými okraji (Shared Borders) je 
sou ástí t chto okraj  to, co vytvo íte, vložíte... p ímo na p íslušném okraji. Pokud vložíte n jaký prvek do 
vlastní stránky a potom ho p etáhnete na sdílený okraj, není tento prvek sou ástí okraje a nebude se automa-
ticky na jiných stránkách zobrazovat. Pokud chcete zm nit p íslušnost prvku (obrázku, obsahu, panelu navi-
gace...) , vyjm te ho z p vodního umíst ní a vložte na jiné cílové místo. 

Provedete to t eba tak, že na prvek klepnete pravým tla ítkem, z místní nabídky vyberete Cut (vyjmout), 
klepnete pravým tla ítkem myši na nové místo (nap . na sdíleném okraji) a zvolíte p íkaz Paste (vložit). 
K dispozici jsou samoz ejm  i klávesové zkratky Ctrl+X, Ctrl+C a Ctrl+V pro vyjmutí, kopírování a vložení. 

A ješt  jedna poznámka – možnost volného umíst ní se zachováním p íslušnosti k p vodnímu umíst ní 
m žete využít i pro opa ný p ípad. M žete nap . chtít na všech stránkách zobrazovat ur itý prvek mimo ob-
last sdílených okraj . Je možné takovýto prvek vytvo it  (nap . vložením obrázku) na sdílený okraj a následn  
ho p etáhnout jinam. A  již bude nov  prvek umíst n na sdíleném okraji nebo ne, bude sou ástí okraje a proto 
se bude zobrazovat na všech stránkách, kde je tento okraj zapnut. 
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Databáze 
Ukázali jsme si na n kolika p íkladech možnost vytvo ení stránek s pevným statickým obsahem. Pokud 

budete chtít takové stránky zm nit, musíte je nahradit novými. To je sice použitelné t eba v p ípad , kdy na 
Webu p edstavuji fotografie z dovolené a stránky budu aktualizovat jednou za p l roku, není to ale použitelné 
v p ípad , kdy budu chtít provád t aktualizaci t eba každý den. P edem zamítneme možnosti programování 
a spolehneme se pouze na to, co poskytuje FrontPage. Nalezneme zde  adu nástroj , které k tomuto úkolu 
m žeme použít.  

Vytvo ili jsme již základní stránky vydavatelství a te  bychom cht li n jak zautomatizovat zobrazování 
publikací. Ideální by k tomu byla n jaká databáze, do které bychom jenom dopl ovali data a webový server 
by již automaticky aktualizoval obsah stránek. A to vše chceme ud lat bez jediného ádku programu. 

P ed tím, než se do tohoto problému pustíme, je t eba upozornit na n kolik v cí. Budete pot ebovat we-
bový server, který podporuje ASP a dokáže spolupracovat i s databází, kterou použijete. Pro vytvá ení strá-
nek, které si ukážeme je nutná podpora FrontPage Server Extension, není ale nutná pro vlastní b h stránek. 
Ukážeme si to sice ješt  pozd ji, ale již te  upozor uji, že výsledky neuvidíte ani p i použití listu Preview ani 
p íkazem File > View in Browser. Musíte stránky publikovat skute n  na webový server, samoz ejm  posta í 
t eba i Personal Web Server (který ostatn  používám já pro ukázky). Více než v jiných dosud zmín ných p í-
padech je nutné si vyzkoušet fungování s r znými prohlíže i než pustíte stránky do sv ta. 

Za neme od vlastních dat, která budeme zobrazovat. P ipravíme si základní údaje t eba v programu Ac-
cess – no dob e, už to slyším až sem, jak se všichni t šíte na Access. Tak sáhnu po n em, co asi mají všichni. 
Doufám, že budete spokojeni s Excelem. Samoz ejm , že použití databázového systému Access vám poskyt-
ne v tší možnosti pro ešení náro n jších úloh, je z n j blíže k nasazení MS SQL Serveru apod. Pro adu úloh 
vám ale skute n  posta í jednoduché nástroje, které znáte. Otev ete Excel a vytvo te si tabulku – databázi. (Já 
se omlouvá, že následující postup bude hodn  podrobný, ale chyba v jednom kroku m že znehodnotit celou 
práci, a pátrání po tom, kde se co špatného událo,, když nemáte dostate n  podrobný popis postupu, by bylo 
velmi úmorné.) 

 

 

Zde je jednoduchá tabulka vytvo ená 
v Excelu. Obsahuje pouze data orientovaná 
po sloupcích. Sloupce tvo í tzv. pole, 
hodnoty v ádcích jsou potom jednotlivé 
záznamy (anglicky record) pro jednotlivé 
knihy. 
D ležitým krokem je ozna ení takto 
vytvo ené oblasti jménem. 
Tažením myší ozna te celou oblast. 
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V následujícím okn  klepnete na tla ítko Add abyste p idali okruh dotaz  do formulá e: 
 

 

V tomto okn  m žete zvolit zam ení formulá e. Je tam 
toho nep eberné množství, ale pro lepší orientaci alespo  
n které: 

- contact information: kontaktní informace 
- product information: informace o výrobcích 
- ordering information: objednávka 
- osobní informace 
- ... 
 
Vedle t chto vlastn  již hotových formulá  m žete 
p idat i díl í polotovary: 
- one of several option: jedna volba z n kolika 
- any of several option: n kolik z více voleb 
- date: datum 
- ... 
 
Dole vidíte v textovém poli úvodní text (Prosím 
poskytn te následující kontaktní informace:), který 
m žete upravit. Úpravy je ale možné ud lat i pozd ji na 
stránce. 
 
 

 
Další okno up es uje položky, které ve formulá i budou obsaženy. Nemá smysl se jimi zabývat detailn , 

v tšinou poznáte o co jde.  Zaškrtn te požadované položky a pokra ujte tla ítkem Next. 
 

  
 

Po stisku tla ítka Next se dostanete do okna, ve kterém m žete p idat další skupinu dotaz . Takovýmto 
zp sobem m žete vyskládat formulá  pln  podle svých pot eb. Pokud se rozhodnete za ít znovu, m žete po-
užít tla ítko Clear List (vymazat seznam). Pro zm nu po adí ozna te n kterou z položek a p esu te ji tla ítky 
Move Up / Down. Jakmile budete s nastavením hotovi klepn te na Next. 
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Tímto zp sobem m žete vytvo it speciální formulá e t eba pro ov ování nebo pro p ístup do diskusní 
skupiny. Pokud ale chcete vytvo it vlastní formulá , nap íklad malou anketu a její výsledky ukládat do soubo-
ru nebo si je nechat zasílat e-mailem, použijte op t pr vodce pro vytvo ení prázdného formulá e – p ejd te 
všechna okna, nikde nic nezadávejte, až v okn  Output Options zvolte zp sob ukládání dat (do soboru, ve for-
mátu HTML nebo odeslat).. 
 

 

Základ formulá e tvo í dvojice 
tla ítek Submit Form 
(odeslání vypln ného 
formulá e) a Reset Form 
(výmaz, obnova formulá e). 
Vlastní formulá  je vyzna en 
árkovanou arou. Zv tšit tuto 

oblast m žete nap . tak, že 
umístíte kurzor p ed tla ítko 
Submit a stisknete Enter, 
t eba i n kolikrát. Do takto 
vytvo eného místa m žete 
vkládat další prvky. 
Pokud chcete využít možnosti 
zarovnávání pomocí tabulky, 
vložte nejprve do formulá e 
tabulku. ádky a sloupce 
m žete do tabulky kdykoliv 
p idat, nebo z ní odebrat. 

 

 

Tabulku vložíte p íkazem 
Table > Insert > Table. Pro 
dodate né vložení dalších 
ádk  nebo sloupc  použijete 

p íkaz Row or Column ze 
stejné nabídky. Pokud 
nebudete chtít obrysy tabulky 
zobrazovat, posta í nastavit 
ve vlastnostech tabulky 
hodnotu tlouš ky okraje – 
Border Size – na nulu. 

 
Jaké prvky máte pro formulá  k dispozici: 

• Online text box – jedno ádkové textové pole pro vkládání jednoduchých text  
• Scrolling text box – textové pole s  posuvníkem, do kterého je možné zadávat rozsáhlé textové zprávy 


